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Session Agenda & Objectives

Learning Objectives:
Create and Apply Template to New 
Pages
Create and Insert Library Items in 
Pages
Quickly Update Site by Modifying the 
Template and Library Items

PowerPoint Presentation
Hands On Labs (the fun stuff!)
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Templates

A File That Is Used to Rapidly Create 
Web Pages with a Consistent Look 
and Feel
Editable Regions: Sections in the 
Template that are Modifiable in Child 
Web Pages
Non Editable Regions: The Sections 
Which Cannot Be Modified in Child 
Web Pages
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Templates

Design-Time Strategy
If Template is Changed, Child Pages 
Must Be Re-Uploaded to Site
Changes in Template Can Propagate 
to All Pages Created from Template
Server Does Not Dynamically Update 
Files
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Library Items

Re-Usable Portions of a Web Page
Changes to the Library Item are 
Propagated to all Pages Containing 
the Library Item

© 2005 Byte Back! Training – Integrating Learning & Technology - www.bbtraining.com

Templates vs. Library Items

Use Templates to Create Entire 
Pages with a Consistent Look and 
Feel for an Entire Site or Portion
Use Library Items to Insert Objects 
(not whole pages) into Multiple Pages 
(but perhaps not the entire site)
Both Allow Pages to be Updated if the 
Template or Library Item is Changed
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Usage Examples:

Re-branding a Web Site or Course
Mergers and Acquisitions
Creating Consistent Course Products



4

© 2005 Byte Back! Training – Integrating Learning & Technology - www.bbtraining.com

More Resources:

Participant Download 
http://learn.bbtraining.com/tk07
Lab Guide in .PDF Format
Sample Files From Labs

Adobe Website
www.adobe.com

Post-Conference Website
http://learn.bbtraining.com/moodle
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Lab Guide Session Description: 
 
This session is designed for users who have some experience with basic web page and site 
creation but have not yet explored templates and library items as a way of streamlining the 
creation of a web site. In this session we will create a simple template and pages based upon the 
template.  We will then create a navigation bar as a library item and re-use it in multiple pages. 
Finally, we will modify the look and feel of the entire site by modifying the template and the 
library item.  
 
Who should attend this session:  Users who have basic computer skills, word processing skills, 
and introductory-level skills with Dreamweaver who want to learn how to create consistent, 
easily maintained web pages for educational (or other) purposes are ideal for this course.  It is 
assumed that you have basic web page creation experience with Dreamweaver.   
 
PCs vs. Mac’s:  Dreamweaver is available for both platforms and the menus and dialog boxes 
provide nearly identical functionality.  The primary difference between the two platforms is 
mostly cosmetic in nature.  While PCs are used in this session, users will be able to easily 
transfer the skills and knowledge attained in this session to the Mac platform.   
 
Session objectives:  At the end of this session, you will be able to perform tasks required for 
creating basic web pages.  You will be able to: 
 

• Create a Dreamweaver Template and use it to create pages with a consistent look and feel 
• Update the template and apply the look and feel changes to the entire site 
• Create and modify a library item for use as a navigation bar 

 
Trademarks:  In this handout we use various references which are trademarked.  These include, 
but are not limited to:   
 
Property of: Examples 
Adobe Adobe, Macromedia, Dreamweaver, 

Photoshop, Fireworks, Dreamweaver, Flash 
 
Other trademarks are the property of their respective owners.  
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Local Site Configuration: 
 
The process of configuring a local site is designed to help you organize the files you create for 
your website and to configure Dreamweaver to be able to upload the files you create on your 
local machine to a web server on the Internet (or other location).  General site configuration has 
two main components; configuring your “local site” to have folders reserved for your site’s 
content, and configuring a “remote site” which is the server that will eventually receive your 
content.  Note that the labs assume you have Windows XP 
 

1. Start Dreamweaver:  Click on Start in the lower left corner of the screen.  Then click 
All Programs.  Next Click on Macromedia and finally, click on Macromedia 
Dreamweaver 8  

2. First, if Dreamweaver is not full-screen, click on the maximize button (arrow). Then 
click on the Site Menu 
 

 
  

3. Next, click on New Site.  On the Site Definition page, click on the Advanced tab at 
the top left.  Then click on Local Info in the left-side menu 

4. In the Site Name field, enter ASTD1 or ASTD2 or ASTD3 (depending upon which 
session you are attending – ask your instructor for details). 

5. Click on the folder icon to the right of the Local root folder field.  Double Click 
either the DW1_W108CS or DW2_W208CS or DW3_FR108CS folder icon (again, 
depending upon which session you are attending).  Note:  In “real life” you would 
create your own folder for the files to be made for your site, but we have pre-
populated these folders with some files for you).   

6. Next click on the Select icon at the lower-right corner 
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7. To the right of the Default images folder click on the folder icon. Double Click on 
the images folder and then click on Select in the lower/right corner (Note: If you see 
an Open button instead of a Select button, you may not have double click on the 
images folder icon). 
 

 
 
 

8. Click on OK at the bottom of the Site Definition pages.  Next, click on Done on the 
Manage Sites page. 

Congratulations.  You have just taken the steps needed to define the folders on your 
computer that will contain your site’s files. 

 

Creating the “Template” Page: 
We have created portions of a template page for you, but you will complete the task by 
deciding which sections of the document should contain "editable regions."  These will be 
the areas that will contain information that is typically unique on each page.  All other 
sections of the page will be non-editable in the "child" documents created from the templates.  
This is what gives template the ability to help create a consistent look and feel for a web site. 
In this section you will:  

• Define the regions of the template that can be editing in the child files 

• Add some non-editable content 

• Save the template in preparation for distribution  

1. There are a few different ways to open the file we have started for you.  One way is to 
Click on File (top left), then click on Open, then select Draft_for_template.html and 
click Open.   (If the proper DW#_ folder is not selected, you can use the navigation tools 
at the top of the Open File dialog box).  The other way is to double click the file from the 
Files Pane on the right as shown below. 
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2. The document will appear. Click on the small triangle to the right of the current menu bar 
(in the screen below, it is the Common option, but your screen may have a different 
menu bar). 
 

 
 

3. On the menu that pops up, click on Show as Tabs option at the bottom of the list.  The 
menus should now appear as shown below.  The tabs (Insert, Common, Layout, Forms, 
etc) allow us to quickly move amongst the many menus.  Briefly click on the tabs and 
observe how the menus change.  When done, click on the Layout tab.   
 

 
 

4. Once Layout has been selected, click on the "other" Layout button shown below 
 

 
 
This will put you in the mode that lets you see table and cell layout designs.  We will use 
that to determine where to add content. 

5. Next, click your mouse anywhere inside the large, top, blue table cell shown below.  We 
will put some banner text there 
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6. At the bottom of the page, we are going to change the text color to white. Click in the box 
shown and select a white box from the color samples. 
 

      Then Select  the white box  
 

7. Next, let's select a larger font size and choose Arial and Bold.  Click on the drop-down 
button shown and pick Arial, Helvetica, Sans Serif.  Then click on the Bold button. 
 

                               
 

8. Finally, we will pick a larger font.  Click on the drop down arrow for the Size value 
(immediately to the right of the font selector we just used) and select xx-Large 

9. Now enter the text Dpix4U.COM (hint: your cursor should still be in the blue banner 
section we selected earlier – Do NOT click your mouse in other areas before typing).  
When done, press CTRL-ENTER to move to the next line.  Your text parameters may 
have been reset to defaults.  Change the color again to white. Change the font to Arial …, 
and change to Bold faced.  Then enter Your resource for digital photography.   

10. Next, click your cursor in the table cell near the top/right section of the page as shown.  
We will put the course title and module name there. 
 

 
11. At the bottom of the screen click on the "Align Right" button.  Then type in the 

following text (if you want, use bold faced type as shown here) Hint: Use CTRL-Enter 
after the first line of text. 
 
Course: Intro to Digital Photography 
Module Name: Lighting Types 
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12. Finally, in the cells at the bottom of the page, we will insert three navigation buttons.  
Click on the bottom/left cell shown below: 
 

 
 

13. With the cursor in this cell, click on the Insert menu at the top of the screen and then 
select Image 
 

 
 

14. If necessary, navigate to the images folder and double click.  Then select the file called 
BlueBack (or blueback.gif), and click on OK 

 
 

15. In the Accessibilities dialog box, for Alternate text: enter Back and click OK 

 
 

16. Repeat this process by clicking in the middle/bottom cell, Insert >> Image, then use the 
BlueMainPG (or bluemainpg.gif) file.    

17. Repeat again for the right/bottom cell. This time select the file called BlueNext (or 
bluenext.gif). Press F12 and click on Yes to Save the file Your page will look similar to 
the graphic below (though we have compressed the image height here to save space). 
Close your browser to return to Dreamweaver. 
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18. Next we will define which regions of the page will be "editable" when a child page is 
created from this template.  Review the image below.  We will want the three cells in the 
center of the page to be editable.  The left column will contain a navigation bar, the 
center column will contain text, and the right column will contain a picture. 
 

 
 

19. Click your mouse in the left cell shown above.  Then click on the boundary for the cell as 
shown in the graphic below.  This selects the whole cell.  
 
If done right the bottom properties section will indicate that you are in a layout cell 
as shown below 
 

 
20. Next, click on the Insert menu 

 

 
21. Then select Template Objects and then Editable Region as shown below 

 

 
 

22. "If" Dreamweaver alerts you that the document will be converted to a template, click on 
OK.  This alert may be turned off if you like (and may have been turned off in other 
classes) 

23. Create a name for this region, we suggest NavBarArea and click OK 
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24. Repeat this process for the center column and the right column.  Suggested names for the 
regions might be TextArea and PictureArea respectively. 

25. Now we will save this file and convert it to a template.  Click on the File menu item, then 
select Save As Template 

26. You may get a warning that about the editable region, if you do, just click OK.  In some 
page designs you might need to reposition the editable region, but our design will work 
fine. 

27. In the Save As Template dialog box, use ContentTemplate for the Save As: name and 
click Save.  When asked if you want to update links, click Yes.  At this stage, this is not a 
critical task, but later, if you were to modify this template, you would click yes in order to 
update all of the pages that were based on this template.   
 

 
 

28. Next, close this file, and any other files you might have opened during the session.  One 
way is to click on the "x" located at the top/right corner of your page (not at the top 
right/right corner of the screen).  Another way is to click on File and then Close. 

29. Congratulations, you now have a template upon which we can easily create new pages 
with a consistent look and feel.  However, we have a minor problem with the template 
because the bottom navigation buttons for Back, Main, and Next are not in an editable 
region.  Hence, we cannot assign links to these buttons on the child pages we create.  I 
ask that you find a solution to this problem and post it at the website at 
http://learn.bbtraining.com  (account there is free – post it in the Dreamweaver section of 
the site).   

http://learn.bbtraining.com/
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Creating Pages Based on Templates: 
 
In the next several steps, we will create "child" web pages that are based on our template.  We 
will see that this will save us from having to recreate the design and static content of the pages 
and allow us to focus on the unique content.   
 

1. Click on  File menu, then click on New  

2. On the New Document window, click on Templates if needed 
 

 
3. In the left pane select the ASTD# (where you select the number of the session you are in 

as indicated by your instructor). In the left pane select the ContentTemplate that you 
recently created. Then click on Create at the bottom/right portion of the window.  An 
"untitled …" page will open up and it will closely resemble your template.  
 

 
 

4. On the page that is opened, click on various portions of your document.  In many areas 
you will see the icon below which indicates that you are in an uneditable region of the 
document.  
 

 
5. In other areas (specifically inside the 3 cells that we marked as editable, your cursor will 

behave normally and allow you to click inside each region and add content 

6. Click in the upper left corner of the center column.  We will place some text in here for 
our students.  

7. Now, go to the right-side Files panel.  You may need to expand the TexDocs folder.  
Then drag the 01_backlit.txt file into the top/left corner of the center column. 
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8. On the Insert Document window, make sure that Insert the contents is selected and 

then click OK 
 

 
 

9. The center column should now contain some text which describes backlighting in 
photography.  If the text does not start at the top of the column, delete the blank line(s).  
Also if there is a lot of space after the title "Backlighting" delete the blank lines.  You 
may also want to make the title bold faced. 

10. Next, click in the upper left corner of the right-hand column. We will insert a photo in 
this right hand column 

11. Next, in the Files panel on the right, find the 01_back.jpg file.  You may need to expand 
the images folder.  Drag this file into the right column.  

12. If you receive a warning about relative path files needing to be saved, simply click on 
OK.  This screen may not show up if it was disabled in previous sessions. 

13. Likewise, if the Accessibility attributes menu is displayed, you can enter a text 
description of the photo in the Alternate text box (sunset picture for example) and click 
OK. 
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14. Click on the File menu and then click on Save 
 

 
  

15. In the Save As Dialog box, enter a File name of  01.html (zero, not an oh) and click on 
Save  

16. Preview your web page by pressing F12 It should resemble the image below 
 

 
 

17. Close the browser.  Then close the 01.html file inside Dreamweaver (you can click on 
File and Close or use the "x" in the upper right corner of the page – not the upper right 
corner of Dreamweaver) 

18. Repeat steps 1-17 above two more times.  You will just need to change a few things 
along the way.  Here they are: 

a. During the first repetition select the following 

i. In step 7 use the file called 02_sidelit.txt 

ii. In step 11 use the file called 02_side.jpg 

iii. In step 15 save your page as 02.html 

b. During the second repetition select the following 

i. In step 7 use the file called 03_Diffused.txt 

ii. In step 11 use the file called 03_Diffused.jpg 

iii. In step 15 save your page as 03.html 

19. Congratulations, you have now created 3 web pages based on your template. 
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Creating Library Items: 
 
In this next section of the labs, we will create a "library item" that will include some useful 
hyperlinks that can be place in the left column of each of our three web pages.  Once the library 
item is created, it can either be re-used by inserting it directly into specific pages, or it can be 
inserted into our template and be passed along to all pages that were based upon the template.  In 
either case, if the library item is changed, pages with the library item will be updated on the local 
site. 
 

1. From the Files panel on the right, Double Click any one of the 3 files you just created 
(either 01.html or 02.html or 03.html) The page should open up as shown in step 2  

2. Now, click in the upper left corner of the left-hand column that is currently empty 

3. Type the following text (hey, you might want to make it bold faced) and then press 
ENTER after each line: (note that some of these lines will not fit in one line of the box, 
don't worry, that's OK)   
 
Useful Links 
Student Site 
ASTD 
TK2007 Conference 

4. Now, triple-click the line about "Student Site." This should select the entire line.  Or, 
you can drag your mouse across the text to select it.  

5. Now click in the Link field of the properties section at the bottom of the page as shown: 
 

 
 

6. In the Link field, enter http://learn.bbtraining.com   and then press the Tab key on 
your keyboard.   

7. Repeat step 4-6 for the ASTD line.  When you get to the Link field, enter 
http://www.astd.org  (don't forget to use Tab to lock the data into the field) 

8. Repeat steps 4-6 for the TK2007 Conference line. When you get to the Link field enter 
http://tk07.astd.org/  (don't forget to use Tab to lock the data into the field) 

9. Now that we have created the hyperlinks portion of the page, we are going to convert it to 
a "library item" which will allow it to be re-used effectively. Place your cursor to the left 
of the letter "U" in Useful Links.  Now Drag your mouse until the title and all 3 links are 
selected. 

10. Next, click on the Modify menu item at the top of the page 
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11. From this menu, select Library and then click on Add Object to Library as shown in 
the graphic below. 
 

 
 

12. In the Assets panel on the right side of the screen, a new, untitled Library item will be 
highlighted.  We will change its name.  Simply type NavLinks which will replace 
"untitled" as the name of the library item.  Press ENTER on the keyboard to create the 
name for the item. 
 

 Change this to read NavLinks 
 

13. The links will have a tinted background. This is an indication that the area is now a 
library item and will not be displayed when the page is viewed by your users.  Please 
click on File from the menu and click on Save. 

14. Preview your file by pressing F12 on the keyboard and confirm that the tint is not 
displayed.  If you get a message about updating the library item, click on the listed file 
and then click on OK.   

15. Then the Update Pages screen may appear, it should indicate that at least one file was 
updated.  If so, click on Close.   Now, close the page you were working on.  

 
In the next set of labs, we will use the library item we just created to add the links to our two 
remaining pages.  Later we will see that if we change the library item, the pages that include it 
can be updated automatically.   
 

1. Open one of the other pages we created earlier, but not the same one in which you created 
the library item.  You can either use the File menu and then choose Open, or you can 
simply double click the file in Files Panel on the right (note, you may have to click on 
Files first, since we were last looking at assets). 
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2. After opening the file, click your mouse in the upper left corner of the left column cell as 
shown below.  Prior to the next step, do not click anywhere else on the screen, the current 
location of the cursor will determine where the library item is inserted 
 

 
 

3. Next, return to your Assets panel by clicking on the link on the right side of the screen. 
 

 
 

4. Next select your NavBarLinks library item by clicking on it once.  Then Right-click on 
it.  From the menu, select Insert as shown: 
 

 
 

5. Look at your leftmost column and insure that your links have been inserted, again, they 
will contain a light tinted background to indicate that this is a library item, but this will 
not display when the page is viewed. 

6. Press F12 to preview the page.  Click on Yes to save the page when prompted. When 
done reviewing the page, close your browser window.  Then close your page in 
Dreamweaver 

7. Repeat Steps 1-6 above for your remaining page. Once done, you should have your links 
on all 3 of the pages we have created.  When done, close all pages. 
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So far we have seen how easy it is to create a consistent look and feel for pages by using 
templates, and we have seen how to re-use a section of a page by inserting library items.  Now 
let's look to see how these objects are affected by updates that need to be applied to an entire site. 
 
Here are a few scenarios where this might be very useful: 
 

• You have created a course for one department in your company.  Another department 
wants the same course, but they want the look and feel of the pages to reflect their 
department's title and color scheme 

• You have moved your content from one portion of a site to a new portion of the site 
and need to change all of the navigation hyperlinks 

• Your company has just been acquired or merged with another company.  They want 
to keep your existing courses, but they want them "re-branded" to reflect the merger. 

• You want to create a new course with a slightly modified look and feel, but the 
original templates would be a good starting point. 

 
In this next set of exercises we will simulate one of these scenarios.  Let's imagine that 
Dpix4U.com was acquired by PixlGarden.com.  Their color scheme is based on the colors in a 
picture of a rose, and they use that picture below their banners. We will change our existing 
template accordingly and then use it to update our 3 files based on the template. 
 

1. In the Files panel on the right side of the screen, double-click the ContentTemplate.dwt 
file to open it. (You may need to click on the Files link first, and you may need to expand 
the templates section of the list using the + sign on its left) 
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2. First, we'll add in the picture of the rose.  To do this we need to add a new cell to the 
template.  Near the top of the screen, make sure that both Layout choices are selected as 
shown below.  Then click on the Draw Layout Cell button (indicated by arrow).   
 

 
 

 

3. A faint grid should be displayed in your page, use it as a guide to draw the layout cell for 
the picture.  See the graphic below, you'll start at the upper left area and drag your mouse 
to create the cell. 
 

 
 

 

4. When you release your mouse, you may get this warning; simply click OK to 
acknowledge this.  Our template will not be impacted by this issue. 
 

 
 

5. Next, click your mouse anywhere inside the cell you just created.  

6. Then, at the top of the screen, click on the Insert menu, then click on Image. If your 
present file location is NOT the images folder, double click on the Images folder to move 
to that location.   
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7. Find the Floral4_50H (or Floral4_50H.jpg) file and select it.  Then click on OK in the 
menu.  On the Accessibility page, type Floral image in the alternate text field then click 
on OK. This should insert the floral picture into your page. 

8. Let's change the title/banner for the page.  Drag your mouse over the text Dpix4U.COM 
then type PixLGarden  Similarly, drag your mouse over Your Resource for Digital 
Photography and type Nourishing your creative instincts  (Note that if you choose to 
delete the text by backspacing over it first, you may have to recreate the text formatting 
options for bold, xx-large, white, etc).   

9. Now, click your mouse on the very edge of the cell, if done properly, the lower properties 
section of the screen should indicate the properties for a Layout cell as shown below 
 

 
 

10. Double click the field next to Bg as shown above, this should highlight it.  Type 
#A65021  This is a color code for a brown color used by PixLGarden.  Now press Tab on 
your keyboard 

11. Repeat steps 9 and 10 for the small cell immediately to the left of the banner and the thin, 
wide cell to the right of the banner. 

12. For the remaining border cells we will use a slightly different process.  We will use an 
eyedropper to pick a color from the photo and use it for the border color.  To start, select 
the left-side border by clicking on its edge.  Again, if done right, the lower-left properties 
section should indicate that you are in a Layout cell.  

13. Now click on the square button to the right of Bg in the properties section.  This allows 
us to select our background color for the cell.  
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14. A color grid will appear.  Move your mouse away from the grid and into the photo of the 
rose petals.  The mouse should resemble an eyedropper. Click on a section of the rose 
that has a shade of medium brightness, a suggested area is shown below: 
 

 
 

15. Repeat steps 12-14 above for the bottom border and the right-side border.  Select any 
color combination that you like for this process.   

16. Next, we'll replace the Back, Main Page, and Next buttons with colors that are a better 
match.  Click on the Back button and press the delete key on your keyboard.   

17. Next click on the Insert menu at the top of the page and select Image (if necessary, 
navigate to the Images folder).  Click on the BrownBack (or Brownback.gif) file and 
click on OK to select the button.  On the accessibility attributes page, enter Back into the 
alternative text field. Then click on OK  

18. Repeat steps 16 and 17 for the Main Page and Next buttons, using the appropriate files 

19. Finally, we'll change the light tint on the background of the entire page.  Click on the 
Modify menu and then select Page Properties as shown: 
 

 
 

20. On the Page Properties dialog box, look toward the center for the entry next to 
Background Color .  Double click the existing entry to select it.  Then type #fff6f6 again 
this is a color code that will become our background color.  
 

21. Now click on OK to save the color change.  (Hint:  You can click on apply first to get a 
glimpse of what that color will look like, then you can try other combinations prior to 
saying OK) 

22. Now click on File and Save to save our updated template 

23. You should see the Update Template Files dialog box.  Click on Update this will cause 
our pages to be updated to match the changes to the template.  
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24. The Update Progress box should appear.  On large sites with numerous pages, this 
process can take a while to update all of the pages which were based on the template.  We 
only have three, so it should complete quickly.  Note the status indicator of how many 
pages were updates.  Click on Close once all 3 pages are updated.   
 

 
 

 

25. Close the ContentTemplate file 

Now, let's look at the results of applying the template.  We will see that all 3 pages we created 
early will now adopt the new look and feel of PixLGarden.   
 

1. From your Files panel, open all three of the pages we created from our original template 
(01.html  02.html and 03.html) 

2. Note the differences in the files.  They should all have been updated to reflect the 
changes we made to the template.  Is that cool, or what?   

3. When done reviewing the files close them.  

 
Finally, we will look at modifying the Library item which contains our hyperlinks.  PixLGarden 
has decided that the links should be part of a table and that a new link should be added to Adobe 
(the makers of Photoshop and Dreamweaver) 
 

1. Click on the Assets panel link on the right 
 

 
 

2. Right click on your NavLinks item in the list and select Edit  from the menu 
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3. The item will open.  When you click on any of the text, it will highlight the entire 
selection as shown below: 
 

 
 

4. Press Delete on your keyboard to remove the existing content. 

5. At the top of the screen select Layout and Standard as shown below so that we can 
insert a table into this library item. Then select the Table icon (circled) 
 

 
 

6. Create a table with: 
5 Rows 
1 Column 
Table Width of 100 Pixels 
Border thickness of 1 
Cell Padding of 1 
Cell spacing of 1 
 

 
7. Then click on OK at the bottom of the box to insert the table 

8. Click in the top cell of the table and type Useful Links (make it bold faced) 

9. In the third cell enter Student Site 

10. In the fourth cell enter ASTD 

11. In the fifth cell enter TK07 Conference 
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12. Press the Tab key to add a new cell. In this cell enter Adobe.com 

13. Triple click the phrase Student Site This should select the text 

14. In the lower properties section, find the Link field and enter 
http://learn.bbtraining.com   The press the tab key to lock the field in.   

15. Triple click the phrase ASTD This should select the text 

16. In the lower properties section, find the Link field and enter http://astd.org   The press 
the tab key to lock the field in.   

17. Triple click the phrase TK07 Conference This should select the text 

18. In the lower properties section, find the Link field and enter http://tk07.astd.org   The 
press the tab key to lock the field in.   

19. Triple click the phrase Adobe.com This should select the text 

20. In the lower properties section, find the Link field and enter http://www.adobe.com   
The press the tab key to lock the field in.   

21. OPTIONAL:  Click anywhere in the table.  Then, on the left/bottom area, click on the tag 
for <table> as shown.  
 

 
 

22. Then, in the Properties section, click on the text entry area next to Brdr color as shown. 
In this field, type #A65021 This will make the table border color match the color in the 
banner area. Then press tab.  
 

 
 

23. Finally, click on the File menu and then click Save.  The Update Library Items menu 
appears. Click on Update.   This will be followed by the Update Pages box.  When it 
shows that all 3 files have been updated, click on Close. 

24. Now, close the library item file.   
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25. Go back to your Files panel and open all 3 of our files (01.html 02.html and 03.html) and 
observe the changes we made as a result of the update to the library item.   
 

     
26. When done, close all files.  Smile!   You're done!   

 
Conclusions: 
 
Templates are a great way to create the foundation for entire pages. 
 
Library items are a great way to create re-usable sections for pages and can be used for specific 
page content. 
 
Have fun. 
 
Don't forget to log in to http://learn.bbtraining.com and join our forums on Dreamweaver and 
Captivate!   This site is free for ASTD members, their colleagues, friends, and family members.  
Only a few rules:  1)  no "flaming" or insulting replies.  2) Content must be PG-13 (or younger).  
3) Help others where possible.  
 
I hope you have enjoyed this session. 
 
Sincerely, 
 
David Schamus 
President 
Byte Back! Training 
Integrating Learning and Technology 
http://bbtraining.com
 

http://learn.bbtraining.com/
http://bbtraining.com/



